
Autodesk Fusion 360 Book
(2nd Edition)

COLORED

By 
Gaurav Verma 

Samar
(CADCAMCAE Works)



Published by CADCAMCAE WORKS, USA. Copyright © 2018. All rights reserved. 
No part of this publication may be reproduced or distributed in any form or by any 
means, or stored in the database or retrieval system without the prior permission of 
CADCADCAE WORKS. To get the permissions, contact at cadcamcaeworks@gmail.
com

ISBN # 978-1-988722-35-1

NOTICE TO THE READER
Publisher does not warrant or guarantee any of the products described in the text or 
perform any independent analysis in connection with any of the product information 
contained in the text. Publisher does not assume, and expressly disclaims, any 
obligation to obtain and include information other than that provided to it by the 
manufacturer.

The reader is expressly warned to consider and adopt all safety precautions that 
might be indicated by the activities herein and to avoid all potential hazards. By 
following the instructions contained herein, the reader willingly assumes all risks 
in connection with such instructions.

The Publisher makes no representation or warranties of any kind, including but not 
limited to, the warranties of fitness for a particular purpose or merchantability, nor 
are any such representations implied with respect to the material set forth herein, 
and the publisher takes no responsibility with respect to such material. The publisher 
shall not be liable for any special, consequential, or exemplary damages resulting, 
in whole or part, from the reader’s use of, or reliance upon, this material.



DEDICATION

To teachers, who make it possible to disseminate knowledge
to enlighten the young and curious minds

of our future generations

To students, who are the future of the world

THANKS

To my friends and colleagues

To my family for their love and support



Table of Contents
Preface											           xvi
About Authors										         xviii

Chapter  1 : Starting with Autodesk Fusion 360
Overview Of Autodesk Fusion 360 							      1-2
Installing Autodesk fusion 360 (Student)					     1-3
Starting Autodesk Fusion 360 							       1-4
Starting a New document 								        1-6
File Menu 											          1-7

New Design From File								        1-7
New Drawing 										          1-8
New Drawing Template 								        1-8
Open details On Web									        1-8
Save 											           1-8
Save As 											          1-10
Recover Documents									         1-11
Export											           1-12
Live Review Session 									         1-13
Share 											           1-16
3D Print											          1-20
Print studio 										          1-22
Capture Image										         1-30
View											           1-31
Script and Add-Ins									         1-33
Fusion 360 App Store 								        1-34

Undo And Redo Button 									        1-36
User Account drop-down 								        1-36

Preferences 										          1-36
Work Offline/Online									         1-39

Help drop-down										          1-39
Search Help Box									         1-39
Learn Fusion 360 									         1-39
Getting Started										         1-40
Diagnostic log Files									         1-40

Data Panel											          1-41
Branch / Merge Options								        1-42
Upload											           1-43
Cloud Account of User 								        1-44

Browser 											           1-44
Navigation Bar										          1-45
Display Bar										          1-46

ViewCube 										          1-46
Mouse Functions									         1-47
Timeline 											          1-47

Self Assessment										          1-49



Chapter  2 : Sketching
Introduction										          2-2
Starting Sketch										          2-2
Sketch Creation Tools									        2-3

Line											           2-3
Rectangle										          2-4
Circle											           2-6
Arc											           2-9
Polygon											           2-11
Ellipse											           2-13
Slot											           2-13
Spline											           2-16
Conic Curve										          2-17
Point											           2-18
Text											           2-18

Sketch Editing Tools									         2-19
Fillet 											           2-19
Trim											           2-20
Extend											           2-21
Break											           2-21
Sketch Scale										          2-22
Offset											           2-22
Mirror											           2-23
Circular Pattern									         2-24
Rectangular Pattern									         2-25
Project/Include									         2-27
Sketch Dimension									         2-27

Sketch Palette										          2-28
Options											           2-28
Constraints										          2-29

Practical 1										          2-33
Practical 2										          2-36
Practical 3										          2-41
Practice 1											          2-47
Practice 2											          2-47
Practice 3											          2-48
Practice 4											          2-48

Chapter  3 : 3D Sketch and Solid Modeling
3D Sketches										          3-2

Creating 3D Sketch									         3-2
Selection Tools										          3-6

Select Tool										          3-7
Window Selection									         3-7
Freeform Selection									         3-8
Paint Selection										         3-8
Selection Tools										         3-8
Selection Priority									         3-11
Selection Filters									         3-11

Solid Modeling										          3-11



vi	              	          Autodesk Fusion 360 Black Book          

Create drop-down										         3-12
New Component									         3-12
Extrude											           3-12
Revolve											           3-19
Sweep											           3-21

Construction Geometry									        3-26
Offset Plane										          3-27
Plane at Angle										          3-28
Tangent Plane										          3-29
Midplane										          3-30
Plane Through Two Edges								        3-31
Plane Through Three Points							       3-32
	 Plane Tangent to Face at Point							      3-33
Plane Along Path									         3-34
Axis Through Cylinder/Cone/Torus						      3-35
Axis Perpendicular at Point								       3-36
Axis Through Two Planes								        3-37
Axis Through Two Points								        3-38
Axis Through Edge									         3-39
Axis Perpendicular to Face at Point						      3-39
Point at Vertex										         3-40
Point Through Two Edges								        3-41
Point Through Three Planes							       3-42
Point at Center of Circle/Sphere/Torus						     3-43
Point at Edge and Plane								        3-43

Project/Include Tools									        3-44
Project Tool										          3-44
Intersect Tool										          3-45
Include 3D Geometry Tool								        3-46
Project to Surface Tool								        3-46
Intersection Curve Tool								        3-48

Self Assessment										          3-50

Chapter  4 : Advanced 3D Modeling
Introduction										          4-2
Loft												            4-2

Guide Type										          4-6
Rib												            4-8
Web												            4-10
Hole												            4-12

Single Hole										          4-12
Multiple Holes										          4-15

Thread											           4-16
Box												            4-18
Cylinder											           4-19
Sphere											           4-20
Torus												           4-21
Coil												            4-22
Pipe												            4-24
Pattern											           4-25



Autodesk Fusion 360 Black Book                        vii

Rectangular Pattern									         4-25
Circular Pattern									         4-27
Pattern on Path									         4-29

Mirror											           4-30
Thicken											           4-31
Boundary Fill										          4-32
Create Form										          4-34
Create Base Feature									         4-34
Create Mesh										          4-34
CREATE PCB FEATURE									         4-35
Self Assessment										          4-36

Chapter  5 : Practical and Practice
Practical 1										          5-2
Practical 2										          5-4
Practical 3										          5-11
Practice 1											          5-15
Practice 2											          5-16
Practice 3											          5-17
Practice 4											          5-17
Practice 5											          5-18
Practice 6											          5-19
Practice 7											          5-20
Practice 8											          5-21
Practice 9											          5-22
Practice 10										          5-23

Chapter  6 : Solid Editing
Solid Editing tools									         6-2
Press Pull											          6-2

Offset Faces										          6-3
Fillet											           6-3

Type drop-down									         6-4
Variable Radius									         6-5

Rule Fillet										          6-6
Chamfer											           6-7
Shell												           6-8
Draft												           6-9
Scale												           6-10
Combine											           6-11
Replace Face										          6-12
Split Face											          6-13
Split Body											          6-13
Silhouette Split										         6-14
Move/Copy											           6-15
Align												           6-18
Physical Material									         6-20
Appearance											          6-21
Manage Materials										         6-22
Delete											           6-23



viii	              	          Autodesk Fusion 360 Black Book          

Change Parameters									         6-23

Chapter  7 : Assembly Design
Introduction										          7-2
New Component 										          7-2

Empty Component									         7-2
From Bodies										          7-3

Joint 											           7-4
Motion											           7-5

As-Built Joint										          7-8
Joint Origin										          7-10
Rigid Group										          7-13
Drive Joints 										          7-13
Motion Link										          7-14
Enable Contact Sets									         7-15

Enable All Contact									         7-16
Disable Contact									         7-17
Create New Contact									         7-17

Motion Study										          7-17
Practical 1										          7-19
Practice 1											          7-22

Chapter  8 : Importing Files and Inspection
Introduction										          8-2
Inserting File										          8-2

Decal											           8-2
Attached Canvas									         8-3
Insert Mesh										          8-5
Insert SVG										          8-7
Insert DXF										          8-8
Insert McMaster-Carr Component						      8-10
Insert a manufacturer part								       8-11

Inspect											           8-12
Measure											          8-12
Interference										          8-14
Curvature Comb Analysis								        8-15
Zebra Analysis										         8-16
Draft Analysis										          8-18
Curvature Map Analysis								        8-19
Section Analysis									         8-21
Center of Mass										         8-22
Component Color Cycling Toggle Tool						      8-23
Check Sketch Tool									         8-23

Chapter  9 : Surface Modeling
Introduction										          9-2

Extrude											           9-2
Patch 											           9-3
Other Solid Modeling Tools For Surfacing					     9-4



Editing Tools										          9-4
Trim											           9-5
Extend											           9-6
Stitch											           9-7
Unstitch											          9-8
Reverse Normal									         9-8

Practical 1										          9-9
Practical 2										          9-23
Practice 1											          9-33
Practice 2											          9-34

Chapter  10 : Rendering and Animation
Introduction										          10-2
Introduction to Render Workspace							      10-2

Appearance Tool									         10-2
Scene Settings										         10-2
Environment Library Tab								        10-5
Texture Map Control									        10-6
In-Canvas Render									         10-8
In-Canvas Render Setting								        10-9
Capture Image										         10-10
Render											           10-11

Animation											           10-16
New Storyboard									         10-16
Transform Components 								        10-17
Restore Home										          10-18
Auto Explode: One Level								        10-19
Auto Explode: All Levels								        10-20
Manual Explode									         10-21
Show/Hide										          10-22
Create Callout										          10-23
View											           10-24
Publish Video										          10-24

Chapter  11 : Drawing
Introduction										          11-2
Starting Drawing Workspace								       11-2

DRAWING VIEW dialog box								       11-3
Creating Base View									         11-4
Creating Projected View								        11-4
Creating Section View									        11-6
Creating Detail View									         11-8
Moving Views										          11-10
Rotating Views										          11-11
Creating Centerline									         11-12
Creating Center Mark									         11-12
Creating Center Mark Pattern							       11-13
Edge Extension										          11-14
Dimensioning										          11-14

Ordinate Dimensioning								        11-15



x	              	          Autodesk Fusion 360 Black Book          

Creating Linear Dimension								       11-15
Creating Aligned Dimension							       11-16
Creating Angular Dimension							       11-17
Creating Radius Dimension								       11-17
Creating Diameter Dimension							       11-18
Baseline Dimensioning								        11-18
Chain Dimensioning									         11-19
Dimension Break									         11-19

Annotation Settings									         11-20
Editing Dimensions									         11-20
Creating Text										          11-22
Creating Leaders										         11-23
Applying Surface Texture Symbol							       11-24

Surface Texture Symbols or Surface Roughness Symbols			   11-25
Creating Feature Control Frame							       11-25

Reading Feature Control Frame							       11-26
Creating Datum Identifier								        11-30
Generating Tables									         11-31
Generating Balloon									         11-32
Bend Identifier and Table								        11-33
Renumbering Balloons									         11-34
Aligning Balloons									         11-34
Generating PDF										          11-36
Generating DWG										          11-37
Generating CSV File									         11-37

Chapter  12 : Sculpting
Introduction										          12-2
Opening the Sculpt Workspace							       12-2
Creation tools										          12-2

Box											           12-3
Plane											           12-5
Cylinder											          12-7
Sphere											           12-8
Torus											           12-9
Quadball											          12-10
Pipe											           12-11
Face											           12-15
Extrude											           12-17
Revolve											           12-19

Modifying tools										          12-21
Edit Form										          12-21
Insert Edge										          12-25
Subdivide										          12-26
Insert Point										          12-27
Merge Edge										          12-28
Bridge											           12-29
Fill Hole											           12-30
Weld Vertices										          12-32
UnWeld Edges										         12-33



Autodesk Fusion 360 Black Book                        xi

Crease											           12-34
UnCrease										          12-35
Bevel Edge										          12-36
Slide Edge										          12-37
Pull											           12-38
Flatten											           12-40
Match											           12-41
Interpolate										          12-43
Thicken											           12-44
Freeze											           12-45
UnFreeze										          12-46

Practical											           12-47
Practice 1											          12-52
Practice 2											          12-53

Chapter  13 : Sculpting-2
Introduction										          13-2
Symmetry Tools										          13-2

Mirror - Internal									         13-2
Circular - Internal									         13-3
Mirror - Duplicate									         13-4
Circular - Duplicate									         13-6
Clear Symmetry									         13-7
Isolate Symmetry									         13-8

Utilities											           13-9
Display Mode										          13-9
Repair Mode										          13-10
Make Uniform										          13-11
Convert											           13-11
Enable Better Performance/Display						      13-12

Chapter  14 : Mesh Design
Introduction										          14-2
Opening the Mesh Workspace								       14-2
Inserting File										          14-3

Insert Mesh										          14-3
BRep to Mesh										          14-4

Modification tools									         14-6
Remesh											           14-6
Reduce											           14-8
Make Closed Mesh									         14-9
Erase and Fill										          14-10
Smooth											           14-12
Plane Cut										          14-13
Reverse Normal									         14-15
Delete Faces										          14-16
Separate											          14-17
Merge Bodies										          14-19
Face Groups										          14-20

Practical											           14-24



Practice											           14-27

Chapter  15 : CAM
Introduction										          15-2
Starting the CAM Workspace								       15-2
Job Setup											           15-3

New Setup										          15-3
Setting a Milling machine								        15-3
Turning											           15-16
Cutting											           15-17

Tool selection										          15-18
Tools Used in CNC Milling and Lathe Machines				    15-21

Milling Tools										          15-21
Lathe Tools or Turning Tools							       15-28

Practical	 1										          15-42
Practical 2										          15-48
Practice											           15-54

Chapter  16 : Generating Milling Toolpaths - 1
Generating 2D Toolpaths								        16-2

2D Adaptive Clearing									        16-2
2D POCKET										          16-10
Face											           16-12
2D Contour										          16-13
Slot											           16-16
Trace											           16-17
Thread											           16-20
Bore											           16-22
Circular											           16-23
Engrave											           16-24
2D Chamfer										          16-26

Generating 3D Toolpath								        16-28
Adaptive Clearing									         16-28
Pocket Clearing									         16-31
Parallel											           16-32
Contour											           16-34
Ramp											           16-37
Horizontal										          16-38
Pencil											           16-39
Scallop											           16-40

Practical											           16-42
Practice 1											          16-53
Practice 2											          16-54

Chapter  17 : Generating Milling Toolpaths - 2
3D Toolpaths										          17-2

Spiral											           17-2
Radial											           17-4
Morphed Spiral									         17-5



Autodesk Fusion 360 Black Book                        xiii

Project											           17-6
Morph											           17-8

Multi-AXIS toolpath									         17-9
Creating Swarf Toolpath								        17-10
Creating Multi-Axis Contour Toolpath						      17-13
Creating Flow Toolpath								        17-15

Creating Drilling Toolpath								       17-17
Practical											           17-20
Practice 1											          17-29
Practice 2											          17-29
Practice 3											          17-30

Chapter  18 : Generating Turning and Cutting Toolpaths
Generating Turning Toolpath								       18-2

Turning Profile										         18-2
Turning Groove									         18-6
Turning Face										          18-9
Turning Single Groove								        18-10
Turning Chamfer									         18-12
Turning Part										          18-15
Turning Thread									         18-16
Turning Secondary Spindle Chuck						      18-19
Turning Secondary Spindle Return						      18-20

Generating Cutting toolpaths							       18-21
Cutting											           18-21

Practical											           18-24
Practice 1											          18-30
Practice 2											          18-31

Chapter  19 : Miscellaneous CAM Tools
Introduction										          19-2
New Folder											          19-2
New Pattern										          19-3

Manual NC										          19-9
WCS Probe										          19-10
Simulate											          19-12
Post Process										          19-15
Setup Sheet										          19-18
Generate Toolpath									         19-19
Clear Toolpath										         19-20
Machining Time									         19-21
Tool Library										          19-21
Task Manager										          19-22

Chapter 20 : Introduction to Simulation in Fusion 360
Introduction										          20-2
Types of Analyses performed in Fusion 360 Simulation			   20-2

Static Analysis										         20-2
Modal Analysis (Vibration Analysis)						      20-3



xiv	              	          Autodesk Fusion 360 Black Book          

Thermal analysis									         20-4
Thermal Stress Analysis								        20-4
Structural Buckling Analysis							       20-5
Event Simulation									         20-5
Shape Optimization									         20-5

FEA												            20-5
Starting Simulation in Fusion 360						      20-5
Performing an Analysis								        20-6
Starting New Simulation Study							       20-7
Simplifying Model For Analysis							       20-7

Removing Features									         20-8
Removing Faces									         20-9
Replace With Primitives								        20-9

Study Material										          20-10
Applying Study Material								        20-10
Displaying Material Properties							       20-11
Managing Physical Material								       20-11
Displaying Study Material Colors							      20-15

Applying Constraints									         20-16
Applying Structural Constraints							       20-16
Applying Bolt Connector Constraint						      20-19
Rigid Body Connector Constraint							      20-21

Applying Loads										          20-21
Applying Structural Loads								        20-22
Applying Linear Global Load (Acceleration)					     20-27
Applying Angular Global Load							       20-28
Toggling Gravity On/Off								        20-28
Editing Gravity										         20-28
Apply Point Mass (Auto)								        20-29
Apply Point Mass (Manual)								       20-30

Applying Contacts									         20-30
Applying Automatic Contacts							       20-30
Modifying Contacts									         20-31
Applying Manual Contacts								        20-33
Manage Contacts Tool								        20-34

Solving Analysis										         20-34
Performing Pre-check									        20-35
Meshing											          20-35
Applying Local Mesh Control							       20-37
Adaptive Mesh Refinement								        20-38
Solving Analysis									         20-39
Preparing and Manipulating the Results					     20-40

Chapter 21 : Simulation Studies in Fusion 360
Introduction										          21-2
Nonlinear Static Stress Analysis							      21-2
Structural Buckling Analysis							       21-4
Use of Buckling Analysis 								        21-5
Modal Frequencies Analysis								       21-6
Thermal Analysis										         21-9



Autodesk Fusion 360 Black Book                        xv

Important terms related to Thermal Analysis					     21-9
Performing Thermal Analysis								       21-10
Thermal Stress Analysis								        21-12
Event Simulation										         21-12
Shape Optimization									         21-12

Preserve Region									         21-13
Setting Shape Optimization criteria						      21-13
Generating Mesh Body of Result							       21-14

Practice 1											          21-15
Practice 2											          21-16
Practice 3											          21-16
Problem 1											           21-17
Problem 2											           21-17

Chapter 22 : Sheetmetal Design
Introduction										          22-2
Sheet Metal Rules									         22-2

Modifying the rules									         22-3
Creating New Sheet Metal Rule							       22-3

Creating Flanges										         22-3
Creating Contour Flange								        22-5

Unfolding Sheetmetal Part								        22-6
Refolding Faces									         22-7

Flat Pattern										          22-7
Exporting DXF										          22-8
Practical											           22-9
Practice											           22-16

Index												           I-1
Ethics of an Engineer								        I-7

Other Books by CADCAMCAE Works							       I-8



Preface
Autodesk Fusion 360 is a product of Autodesk Inc.  Fusion 360 is the first of its 
kind software which combine 3D CAD, CAM, and CAE tool in single package. It 
connects your entire product development process in a single cloud-based platform 
that works on both Mac and PC. In CAD environment, you can create the model with 
parametric designing and dimensioning. The CAD environment is equally applicable 
for assembly design. The CAE environment facilitates to analysis the model under 
real-world load conditions. Once the model is as per your requirement then generate 
the NC program using the CAM environment.

The Autodesk Fusion 360 Black Book (2nd Edition) is the second edition of our series 
on Autodesk Fusion 360. The book is updated on Autodesk Fusion 360 Ultimate, 
Student V 2.0.4116. With lots of features and thorough review, we present a book to 
help professionals as well as beginners in creating some of the most complex solid 
models. The book follows a step by step methodology. In this book, we have tried to 
give real-world examples with real challenges in designing. We have tried to reduce 
the gap between educational use of Autodesk Fusion 360 and industrial use of 
Autodesk Fusion 360. This edition of book, includes latest topics on Sketching, 3D 
Part Designing, Assembly Design, Rendering & Animation, Sculpting, Mesh Design, 
CAM, Simulation, Sheetmetal, 3D printing, 3D PDFs, and many other topics. The 
book covers almost all the information required by a learner to master the Autodesk 
Fusion 360. The book starts with sketching and ends at advanced topics like CAM, 
Simulation, and Mesh Design. Some of the salient features of this book are :

In-Depth explanation of concepts
Every new topic of this book starts with the explanation of the basic concepts. In this 
way, the user becomes capable of relating the things with real world.

Topics Covered
Every chapter starts with a list of topics being covered in that chapter. In this way, 
the user can easy find the topic of his/her interest easily.
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Instruction through illustration
The instructions to perform any action are provided by maximum number of 
illustrations so that the user can perform the actions discussed in the book easily 
and effectively. There are about 1700 small and large illustrations that make the 
learning process effective.

Tutorial point of view
At the end of concept’s explanation, the tutorial make the understanding of users 
firm and long lasting. Almost each chapter of the book has tutorials that are real 
world projects. Moreover most of the tools in this book are discussed in the form of 
tutorials.

Project
Free projects and exercises are provided to students for practicing.

For Faculty
If you are a faculty member, then you can ask for video tutorials on any of 
the topic, exercise, tutorial, or concept.

Formatting Conventions Used in the Text
All the key terms like name of button, tool, drop-down etc. are kept bold.

Free Resources
Link to the resources used in this book are provided to the users via email. To get the 
resources, mail us at cadcamcaeworks@gmail.com with your contact information. 
With your contact record with us, you will be provided latest updates and informations 
regarding various technologies. The format to write us mail for resources is as follows:

Subject of E-mail as Application for resources of ________book.
Also, given your information like
Name:
Course pursuing/Profession:
E-mail ID: 

Note: We respect your privacy and value it. If you do not want to give your personal 
informations then you can ask for resources without giving your information.
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About Authors
The author of this book, Gaurav Verma, has authored and assisted in more than 16 
titles in CAD/CAM/CAE which are already available in market. He has authored 
AutoCAD Electrical Black Books which are available in both English and Russian 
language. He has also authored books on various modules of Creo Parametric 
and SolidWorks. He has provided consultant services to many industries in US, 
Greece, Canada, and UK. He has assisted in preparing many Government aided 
skill development programs. He has been speaker for Autodesk University, Russia 
2014. He has assisted in preparing AutoCAD Electrical course for Autodesk Design 
Academy. He has worked on Sheetmetal, Forging, Machining, and Casting in Design 
and Development department.

If you have any query/doubt in any CAD/CAM/CAE package, then you can contact 
the authors by writing at cadcamcaeworks@gmail.com

 

For Any query or suggestion
If you have any query or suggestion, please let us know by mailing us on 
cadcamcaeworks@gmail.com. Your valuable constructive suggestions will be 
incorporated in our books.



Chapter  1

Starting with Autodesk
Fusion 360

Topics Covered

The major topics covered in this chapter are:

•	 Overview of Autodesk Fusion 360
•	 Installing Autodesk Fusion 360 (Educational)
•	 Starting Autodesk Fusion 360
•	 File Menu
•	 User Account drop-down
•	 Data Panel
•	 Simulation Browser
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OVERVIEW OF AUTODESK FUSION 360 
Autodesk Fusion 360 is a new Autodesk product designed to be a powerful 3D 
Modeling software package with an integrated, parametric,feature based CAM module 
built into the software. Autodesk Fusion 360 is the first 3D CAD, CAM, and CAE tool 
of its kind. It connects your entire product development process in a single cloud-
based platform that works on both Mac and PC; refer to Figure-1. 

 

Figure-1. Overview

It combines industrial and mechanical design, collaboration, simulation, and 
machining in a single software. The tools in Fusion 360 enable rapid and easy 
exploration of design ideas with an integrated concept to production toolset. This 
software needs a good network connection to work in collaboration with other team 
members. 

This is a good software for those individual and companies who want to develop 
themselves. This software is much affordable than any other software offered by 
Autodesk. To use this software, one need to pay the monthly subscription of Fusion 
360. You can work offline in this software and later save the file on Autodesk Server. 
User can access this software from anywhere with an internet connection.  The user 
is able to open his saved file and also able to share files with anyone from anywhere 
as long as he has the software and good internet connection. Also, the pricing of this 
software is cost effective so anyone can use it for manufacturing of tools and parts. 
Autodesk Fusion 360 has been built to work in multi body manner: both parts and 
assemblies built in a single file. The procedure to install the software is given next.
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INSTALLING AUTODESK FUSION 360 (STUDENT)
• Connect your pc with the internet connection and then login to 
http://www.autodesk.com/products/fusion-360/students-teachers-educators as 
shown in Figure-2. 

Figure-2. Autodesk website

• Click on the Create Account button and on next page, select your Country and 
Education role. In Country drop-down, select your Country and in Education role 
drop-down, you need to select Student (There is free subscription for students with 
license term of 3 years) as shown in Figure-3.
 

Figure-3. Select country and education role

• After filling the details, click on NEXT button. The next page of this website opens. 
In this page, you need to fill your personal details and then click on Create Account 
as shown in Figure-4. 
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Figure-4. Creating account

•	 After creating account, you need to verify your E-mail address by login into your 
E-mail account. After verifying E-mail address, you need to give your Education 
details. 

•	 After completion of these processes, you need to sign-in your Autodesk Account 
and search the Autodesk Fusion 360 software.

•	 Download the Autodesk Fusion 360 software. 
•	 Open the downloaded setup file and follow the instructions as per the setup 

instruction.
•	 The software will be installed in couple of minutes.
 

STARTING AUTODESK FUSION 360 
•	 To start Autodesk Fusion 360 from Start menu, click on the Start button in 

the Taskbar at the bottom left corner, click on All Programs folder, and then on 
Autodesk folder. Select the Autodesk Fusion 360 icon; refer to Figure-5. 
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Figure-5. Start Menu
•	 While installing the software, if you have selected the check box to create a desktop 

icon then you can double-click on that icon to run the software. 
•	 If you have not selected the check box to create the desktop icon and want to 

create the icon on desktop now, then right-click on the Autodesk Fusion 360 icon 
in the Start menu and select the Send To-> Desktop(Create icon) option from 
the shortcut menu displayed. If you are using Windows 8 or later then drag the 
Autodesk Fusion 360 icon from Start menu to Desktop. 

After clicking on the icon, the Autodesk Fusion 360 software window will be displayed; 
refer to Figure-6.

Figure-6. Autodesk Fusion 360 application Window
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STARTING A NEW DOCUMENT 
•	 Click on the File drop-down and select the New design tool as shown in Figure-7. 

A new document will open.

Figure-7. File Menu
•	 Select the desired workspace from the Workspace drop-down; refer to Figure-8. 

Figure-8. Workspace drop-down

•	 There are seven buttons available in Workspace drop-down; MODEL, PATCH, RENDER, 
ANIMATION, SIMULATION, CAM, and DRAWING. 

•	 The MODEL button is used to activate workspace in which you can create solid 
bodies. 

•	 The PATCH button is used to activate workspace for designing surface.

•	 The SHEET METAL button is used to activate workspace for designing sheet metal 
parts.

•	 The RENDER button is used to activate workspace for preparing model for 
presentation. 

•	 The ANIMATION button is used to activate workspace for creating automatic or 
manual exploded views as well as direct control over unique animation of parts 
and assemblies. 
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•	 The SIMULATION button is used for Engineering Analysis. 

•	 The CAM button is used for producing CNC codes. 

•	 The DRAWING button is used for generating drawing and sketch. 

You will learn more about these work-spaces later in this book. 

FILE MENU 
The options in the File menu are used to manage files and related parameters. 
Various tools of File menu are discussed next.

New Design From File
This is used to import the file into Fusion 360 software. The steps to do so are given 
next.

•	 Click on the New Design From File tool from the File menu; refer to Figure-9. 
The Open dialog box will be displayed.

Figure-9. New Design 
From File tool

•	 Select the desired format from the File Type drop-down; refer to Figure-10 and 
double-click on the file to be imported. 

Figure-10. Open dialog box
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This command supports file formats: 

• Autodesk Fusion 360 Archive Files (*.f3d)
• IGES (*ige, *iges, *igs)
• SAT/SMT Files (*.sat, *.smt)
• STEP Files (*.step, *.stp)

New Drawing 
The New Drawing tool is used for initiating a new drawing from animation or design; 
refer to Figure-11. The method to use this tool will be discussed later in the book.

Figure-11. New Drawing

New Drawing Template 
The New Drawing Template tool is used to create a template for generating drawings 
of the model; refer to Figure-12. You will learn about this option later in this book.

Figure-12. Related Data

Open details On Web
The Open Details On Web tool is used to display the details of current file in web 
browser. You can use this option only after you have saved your file on Autodesk 
cloud.

Save 
The Save tool is used to save the current file. You can press CTRL+S key from keyboard 
to save file. 

Figure-13. Save tool

 

•	 Click on the Save tool from File menu or select the Save button from application 
bar as shown in Figure-13. The Save dialog box will be displayed asking you to 
specify the Name and Location of your file; refer to Figure-14. 
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Figure-14. Save dialog box

•	 Specify the desired name in the Name edit box.
•	 Click on the down arrow next to Location edit box in the dialog box. A list of 

locations available in Autodesk Cloud will be displayed; refer to Figure-15.

Figure-15. Locations to save file
•	 By default, Demo Project is added in the Project list. To add a new project, click 

on the New Project button at the bottom left corner of the dialog box. You will be 
asked to specify name of the new project; refer to Figure-16.
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Figure-16. Specifying Project name

•	 Specify desired name for the project in displayed edit box and click anywhere in 
blank area of the dialog box.

•	 Click on the arrow displayed before your new project. The master folder will be 
created automatically under the new project and the location will be selected as 
save location for your file; refer to Figure-17.

Figure-17. Location selected for saving file

•	 If you want to create folder in the project with desired name then click on the 
New Folder button from the dialog box. You will be asked to specify the name of 
the folder.

•	 After setting the desired parameters, click on the Save button. The file will be 
saved at specified location.

Save As 
Using the Save As tool, you can save the file in desired format. The procedure to use 
this tool is discussed next.

•	 Click on Save As tool from File menu; refer to Figure-18. The Save As dialog box 
will be displayed as shown in Figure-19.
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Figure-18. Save As Tool

Figure-19. Save As dialog box

•	 Specify desired name and location for the file, and click on the Save button.  

Recover Documents
The Recover Documents tool is used to recover your last unsaved file; refer to Figure-20. 
Note that this tool will be active only when you have some unsaved work and software 
closes unexpectedly. The procedure to use this tool is given next. 
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Figure-20. Recover Documents tool

•	 Click on the Recover Documents tool from the File menu. The File Recovery 
dialog box will be displayed where you need to select your unsaved file; refer to 
Figure-21. 

Figure-21. File Recover

•	 Double-click on the file that you want to be recovered and click on the Open button 
from the displayed menu. The file will open in Autodesk Fusion 360. 

Export
The Export tool is used to export the file in various different formats. 
The procedure to use this tool is given next.

•	 Click on the Export tool from the File menu; refer to Figure-22. The Export dialog 
box will be displayed; refer to Figure-23. 

Figure-22. Export tool

 

•	 In the Type drop-down, there are five options to specify export format; F3D, IGES, 
SAT, STM, and STEP. Select the desired format from the drop-down.
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Figure-23. Export dialog box

•	 Select the Save to a project in the cloud check box if you want to save the 
file on cloud otherwise make it clear. Note that this check box is available only 
for Archive Files (*.f3d) format. If you are saving this file for the first time on 
cloud then the Save to a project in the cloud dialog box will be displayed on 
clicking the Save button; refer to Figure-24. Select the desired project from the 
Project drop-down in the dialog box and click on the Select Project. The file 
will be saved in selected project on cloud.

Figure-24. Save to a project in the  cloud

•	 You can also save the file to your computer by selecting the Save to my computer 
check box. On selecting this option, click on the browse button next to Save to 
my computer field to specify the location of file where you want to save the file. 

•	 Click on the Save button to save the file.

Live Review Session 
Till the time of writing this book, the Live Review Session tool is under preview 
mode and not an active part of software. To use this tool, you must be in online 
mode with file saved on cloud. The Live Review Session tool is used to collaborate 
with your colleagues on current model. The procedure to use this tool is given next.
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•	 Click on the Live Review Session tool from the File menu; refer to Figure-28. 
The Fusion 360 dialog box will be displayed asking you to enable preview of the 
feature if you have not opted to display preview tools earlier while installing. Click 
on the Enable button from the dialog box. The LIVE REVIEW SESSION dialog box 
will be displayed in the left of application window; refer to Figure-25.

Figure-25. Live Review Session dialog 
box

•	 Copy the link in Share this link to invite others edit box and distribute it to 
participants via E-mail or other methods. (Your participants need to open the link 
in their web browser to participate. Note that their web browser should support 
OpenGL to display model.)

•	 Type desired comments in the input box at the bottom and press ENTER key. The 
message will be displayed to all the participants in Chat history area of the box.

•	 On opening the link in web browser, your participants will see the A360 window 
as shown in Figure-26. Participant need to specify his/her name and click on 
the Join button. On doing so, the Live Review window of part will be displayed; 
refer to Figure-27.
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Figure-26. A360 window displayed

Figure-27. Live Review window

•	 After checking the model and giving desired instructions, your participants can 
click on the Exit button at the top right in their web browser. Note that your 



1-16	                        Autodesk Fusion 360 Black Book                  

participants cannot modify the model but any modifications you perform during 
the review session will be reflected immediately in their model.

•	 After completing session, click on the Stop button and then click on the End 
Session button to close live review session. The Session has been ended message 
will be displayed in your participants web browsers.

 

Figure-28. Live Review Session

Share 
The Share tools are used to share the file or project on various portals. Click on 
the Share tool from File menu. Three options will be displayed in Share cascading 
menu; refer to Figure-29. 

Figure-29. Share cascading menu

Share Public Link
The Share Public Link tool is used to share the project link with anyone. The 
procedure to use this tool is discussed next. 

•	 Click on Share Public Link tool of Share cascading menu from File Menu.
•	 On selecting this tool, the Share Public Link dialog box will be displayed, refer 

to Figure-30.
•	 Click on the toggle buttons to activate or de-activate respective functions.
•	 After activating the sharing function, copy the link from Copy box and share the 

link via E-mail or other method with anyone. Set the Allow item to be downloaded 
toggle button active to allow downloading of file.
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Figure-30. Share Public Link dialog box
Share To Fusion 360 Gallery

The Share To Fusion 360 Gallery tool is used to share the file online to the gallery 
of Fusion 360 where the file is accessible to everyone registered with the gallery. The 
procedure to use this tool is given next.

•	 Click on Share To Fusion 360 Gallery tool from Share cascading menu. The 
SHARE TO FUSION 360 GALLERY dialog box will be displayed; refer to Figure-31. 

•	 Click on the NEW PROJECT button from the dialog box. The options will be displayed 
as shown in Figure-31.

Figure-31. SHARE TO FUSION 360 GALLERY dialog box
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Figure-32. Share To Fusion 360 Gallery dialog box
•	 Scroll down in the dialog box and specify the information as required.
•	 Once all the desired information is specified, select the I have read and agree 

to the Autodesk Terms of Use check box and click on the Publish button. Your 
project has been successfully shared message will be displayed.

•	 Click on the Go and take a look! button to check your model in gallery.

Publish to GrabCad
Autodesk Fusion 360 allows you to publish your model directly to GrabCad portal. 
The procedure to use this tool is given next.

•	 Click on Publish to GrabCad tool from Share cascading menu. The PUBLISH TO 
GRABCAD dialog box will be displayed; refer to Figure-33.

•	 Login to GrabCAD platform with your GrabCAD account details to upload or share 
the project. If you do not have an account on GrabCAD then you can create the 
account by clicking on Sign Up button and following the instructions. 

•	 Once you have login to your account, the dialog box will be displayed as shown 
in Figure-34.
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Figure-33. PUBLISH TO GRABCAD 
dialog box

   

Figure-34. PUBLISH TO GRABCAD 
dialog box

•	 Click on the New Library Model link button if you want to save model in community. 
If you want to create a workbench model then click on the Workbench tab in the 
dialog box and then click on the New Workbench Project link button. Based on 
your selection, the respective information will be displayed in the dialog box; refer 
to Figure-35.

Figure-35. New Workbench Project details

•	 Set the desired parameters and click on the Create project button. In the next 
page, click on the Publish Here button. Your model will be uploaded to Grabcad.
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3D Print
The 3D Print tool is used to prepare and send current model for 3D printing. This tool 
convert the selected body to Mesh Body and sends the output to 3D-Print utility 
and STL. The procedure to use this tool is given next.

•	 Click on the 3D Print tool from the File menu or click on the 3D Print tool from 
the Make panel in the Toolbar; refer to Figure-36. The 3D-PRINT dialog box will be 
displayed; refer to Figure-37. 

Figure-36. 3D Print

Figure-37. 3D-Print Dialog box

•	 By default, the Selection button is active in this dialog box and you are prompted 
to select model to be 3D printed. Click on the model to be 3D Printed.

•	 Now, select the Preview Mesh check box to see the number of triangles forming 
in the selected body.

•	 Select the desired level of resolution for printing in Refinement drop-down menu. 
There are four resolution in this drop-down. If you select the High, Low, and Medium 
command then the Surface deviation, Normal deviation, Maximum Edge Length, 
and Aspect Ratio parameters in the Refinement Options section will be adjusted 
automatically. (Click on the arrow before Refinement Options node to expand the 
section.) If you want to adjust these parameters manually then you need to select 
the Custom option in Refinement drop-down; refer to Figure-38. 
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Figure-38. Refinment

 

•	 Select the Send to 3D Print Utility check box in Output section to further edit 
the model in 3D printing utility. Select desired 3D Printing utility in Print Utility 
drop-down; refer to Figure-39. Note that 3D printing utilities are not installed 
automatically during Fusion 360 installation. On selecting the utility in Print 
Utility drop-down, an option to download and install the utility is displayed in 
the dialog box; refer to Figure-40. Download and install the desired utility.

Figure-39. Output 3D-Print

   

Figure-40. Option to download Print utility

•	 Clear the Send To 3D Print Utility check box if you want to save the project 
file in STL format so that you can open this file later in any 3D Printing software.

•	 In our case, we have selected Print Studio option from the Print Utility drop-
down (Needless to say, we have installed it also). Click on the OK button from 
the dialog box. The Print Studio application window will be displayed; refer to 
Figure-41. 
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Figure-41. Print Studio Window

The tools of this application are discussed next.

Print studio 
On selecting the OK button from Print Studio dialog box, the file is exported from 
Autodesk Fusion 360 and imported to Autodesk Print Studio.
 

Specifying 3D Printer 
•	 To set desired 3D Printer, click on the Change Printer button at upper left corner; 

refer to Figure-42. The Printers dialog box will be displayed. In this dialog box, 
you can select the printer connected via USB or connected at network.

Figure-42. Selecting a 3D printer

•	 If you want to use the Print Services tools to modify parts then click on the 
Prepare button in the Print Services Section. 
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•	 If you want to print later and want to create printable file for your printer then 

select the desired printer model from Create a print file for drop-down and 
click OK button of Printers dialog box. 

Change Material and Printer Setting 
This tool is used to change the material and other settings to use 3D printer optimally.

•	 To change material, click on the Change Material and Printer Setting button 
below the Change the Printer button in the left toolbar; refer to Figure-43. 
The Settings dialog box will be displayed; refer to Figure-43. Select the Profile 
according to your needs in Profiles drop-down. In Basic Setting section, specify 
the desired parameters like height of each layer, pattern of infill in printing, infill 
density etc. Select the Enable raft check box if you are using raft at the base for 
better adhesion and stability of printed model. 

Figure-43. Changing Material and Printer Setting

•	 If you want to specify advanced parameters like, support dimensions, Infill pattern, 
extruder temperature, and so on then, click on Advanced Setting button and 
specify the desired parameters.

•	 After setting the desired parameters, click on Save button from Settings dialog box. 

Toolbar 
The tools in the Toolbar of Print Studio application are used to finalize the project 
for 3D printer step by step; refer to Figure-44. 

Figure-44. Print Studio Toolbar
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Import Tools
Import tool is used to import the file to Autodesk Print Studio. We have already 
imported the file so the button is displayed selected in the toolbar in the Figure-44.

Layout Tools
Layout tool is used to position the model on printing tray. On selecting this tool, 
the toolbar for layout will be displayed on the left of the application window; refer 
to Figure-45.

Figure-45. Layout

•	 Click on the Move tool and move the model at desired location by dragging.
•	 Click on the Scale button from left toolbar if you want to scale up or scale down 

the model. The SCALE box will be displayed next to the Scale button. Specify the 
desired percent scale value in Scale Factor edit box and press ENTER. 

•	 Click on the Measure button if you want to measure your model before printing. 
You will be asked to specify start and end points for measurement. 

•	 If you want to change the face of model to be resting on the printer bed then click 
on the Lay Flat button from the left toolbar and select the desired face.

Repair Tools
After setting the parameters of Layout tool, next step is to repair the model. On 
selecting the Repair tool from Toolbar section, a repair tool box will be displayed at 
the left of screen. This tool detects the model issues like holes and other geometry 
defects cannot be printed by 3D printer. You can resolve these issues manually 
or automatically. When issues are resolved, this tool display a notification i.e. No 
Problems; refer to Figure-46. 

Figure-46. Repair in Print 
Studio
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•	 Click on the Find and Repair button  to automatically find and repair faults in 
the model. The ANALYZE AND REPAIR toolbox will be displayed; refer to Figure-46. 
Click on the Inspect Geometry button from the toolbox to find problematic areas. 
The problematic areas will be highlighted in the viewport; refer to Figure-47. Click 
on the Auto Repair button to automatically repair the model.

Figure-47. Finding and repairing errors

•	 Click on the Select Regions tool from the left toolbar to select different regions of 
model and apply basic operations. The Select Regions toolbox will be displayed; 
refer to Figure-48.

Figure-48. SELECT RE-
GIONS toolbox

•	 Click on the desired button from the toolbox. Click on the Pick button to select 
individual feature of the model. Click on the Lasso button to select features of model 
using freehand selection region. After selecting this tool, click on the model and 
drag cursor to form selection region; refer to Figure-49. Click on the Box button 
and draw a rectangle to select features that fall inside the created rectangle.
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Figure-49. Lasso region created

•	 On selecting features, a round button (Action icon)  is displayed in the viewport. 
Click on this button to display context toolbar (Action wheel); refer to Figure-50. 
Click on the desired button to perform respective operation on selected faces.

•	 Click on the Crop button  to isolate selected region and delete rest of the model 
for printing; refer to Figure-51. You can modify the selection by using rotation 
and translation handles displayed on the box.  Click on the round OK button at 
the bottom of selection box to applying cropping. Press ESC to exit cropping mode.

Figure-50. Context toolbar

  

Figure-51. Region created for croppping
•	 Click on the Patch Holes tool to close open areas of the model. The PATCH HOLES 

toolbox will be displayed; refer to Figure-52. Click on the Bridge button to create 
boundaries for filling. Click on the Fill button after selecting the open region to 
fill it; refer to Figure-53.

Figure-52. PATCH 
HOLES toolbox
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Figure-53. Filling open region

•	 Click on the Plane Cut tool from the left toolbar to check insight of model. The 
PLANE CUT toolbox will be displayed with X, Y, and Z buttons. Click on the desired 
button create section. Press ESC to exit the tool.

•	 Click on the Balance tool from the left toolbar to check whether the part will be 
stable during 3D printing or not. The BALANCE toolbox will be displayed. Click on 
the Suggest Base button from the toolbox to display the faces that can be used 
as base; refer to Figure-54. Select the desired face to be used as base.

Figure-54. Bases suggested by Balance tool

Supports Tools
The Supports tools are used for giving support to model which do not have flat base. 
To apply supports, click on the Supports tool from the top toolbar. The AUTO SUPPORTS 
toolbox will be displayed in the left of screen; refer to Figure-55. 

•	 Click on the Optimize Rotation tool to orient the model at optimum position for 
3D printing. This tool considers the dimensions of part and available space on bed. 
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•	 Click on the Add Supports tool from the AUTO SUPPORTS toolbox to automatically 
apply supports to the model which is not stable during 3D printing; refer to 
Figure-55.

Figure-55. Applying supports to model

•	 Click on the Delete Supports tool to delete automatically applied supports.
•	 Click on the Manual Supports tool from the left toolbar to manually define supports 

for the model. You will be asked to specify start and end points of the support. 
Click at the desired locations on model and printer bed to create support; refer 
to Figure-56. Create as many supports as required.

Figure-56. Creating support manually

Preview
•	 Click on the Preview tool from top toolbar to check preview of 3D printed model. 

System will start generating toolpath and the PREVIEW SLICES toolbox will be 
displayed once toolpath generation is finished; refer to Figure-57.

•	 In Preview Slices Box, you can check the time taken by printer and  volume of 
model in Estimated time and Estimated volume section. By moving the slider in 
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PREVIEW SLICES toolbox, you can see the formation of model layer by layer. 
 

Figure-57. Preview tool

Click on the Export Printer File from PREVIEW SLICES toolbox or click on the 
Export tool from top toolbar to save the printer ready file. The Save As dialog box 
will be displayed; refer to Figure-58. Specify desired name and location for the file, 
and click on the Save button.

Figure-58. Save As dialog box for 3D printing file

You can save the Print Studio file of current model by using CTRL+S in 3PS format 
if you want to store and share the file with your colleagues. Now, you can close the 
Print Studio window by pressing CTRL+X or clicking on the Close button at top right 
corner.
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Capture Image
The Capture Image tool is used to capture the image of model in current state. The 
procedure is discussed next. 

•	 Click on the Capture Image tool from File menu; refer to Figure-59. The Image 
Options dialog box will be displayed. 

Figure-59. Capture Image tool

•	 Select the desired option from the drop-down in Image Resolution area to define 
size of image. All the other parameters of Image Resolution area will be defined 
automatically. 

•	 If you want to set image resolution other than the standard one then select the 
Custom option from the drop-down and define the parameters. By default, you are 
asked to specify size in pixels but you can also define the image size in inches by 
selecting the Inch option from the drop-down next to Width edit box. Now, you 
will be able to define pixel density in the Resolution edit box manually. Clear the 
Lock Aspect Ratio check box to specify values of height and width individually. 

•	 Select Transparent Background check box for setting the background of the image 
to be transparent. 

•	 Select the Enable Anti-aliasing check box to smooth jagged lines or textures 
by blending the color of an edge with the color of pixels around it.

•	 After setting desired parameters, click on the OK button of Image Options dialog 
box. The Save As dialog box will be displayed; refer to Figure-60.
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Figure-60. Save As dialog box for image capturing

•	 Select the desired format from the Type drop-down for image. There are three 
formats available: PNG, JPG, and TIFF.

•	 Set the other parameters as discussed earlier and click on the Save button to 
save the image.

View
The View tool is used to show and hide various elements of Fusion 360 application 
window.

•	 Click on the View tool from File menu. The View cascading menu will be displayed; 
refer to Figure-61. 

Figure-61. View cascading menu

Various tools in this cascading menu are given next.
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Hide ViewCube 
The Hide ViewCube tool is used to hide the ViewCube. If the ViewCube is already 
hidden then Show ViewCube tool will be displayed in place of it. On again selecting 
this tool, View Cube will be displayed. You can also show/hide ViewCube by pressing 
the CTRL+ALT+V keys. 

Hide Browser
The Hide Browser tool is used to hide the Browser from the current screen. If the 
Hide Browser is already hidden then Show Browser tool will be displayed in place of 
it. This tool can also be activated by pressing CTRL+ALT+B together.

Hide Comment 
The Hide Comment tool is used to show and hide the Comments from Fusion 360 
software. If the Hide Comment is already hidden then Show Comment tool will be 
displayed in place of it. This tool can also be used by pressing CTRL+ALT+A together.

Show Text Commands 
The Show Text Commands tool is used to show Text Commands Bar. If the Show Text 
Commands is already displayed then Hide Text Commands tool will be displayed in 
place of it. This tool can also be activated by pressing CTRL+ALT+C together.

Hide Toolbar 
The Hide Toolbar tool is used to hide the Toolbar. If the Hide Toolbar is already 
hidden then Show Toolbar tool will be displayed in place of it. This tool can also be 
used by pressing CTRL+ALT+W together.

Hide Navigation Bar
The Hide Navigation Bar tool is used to hide the Navigation bar. If the Navigation 
Bar is already hidden then Show Navigation Bar tool will be displayed in place of 
it. This tool can also be activated by pressing CTRL+ALT+N together.

 
Show Data Panel

The Show Data Panel tool is used to show the Data Panel. If the Data Panel is already 
showing then Hide Data Panel tool will be displayed in place of it. This tool can also 
be activated by pressing CTRL+ALT+P together.

Show Getting Started
The Show Getting Started tool is used to display GETTING STARTED dialog box. Select 
the desired unit system and navigation control scheme from the dialog box. Click 
on the START HERE button to check tutorials on Autodesk Fusion 360. Click on the 
Close button from the dialog box to close it.

Reset To Default Layout
The Reset To Default Layout tool is used to reset user interface to default settings. 
This tool can also be used by pressing CTRL+ALT+R together. 
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Script and Add-Ins
The Script and Add-Ins tool is used to run and manage Script and Add-Ins in 
Autodesk Fusion 360. The procedure to use this tool is discussed next.

•	 Click on Script and Add-Ins tool from File menu. The Script and Add-Ins dialog 
box will displayed; refer to Figure-62. 

Figure-62. Script and  Add-ins

There are two tabs in this dialog box; Scripts and Add-ins. Select the Script tab to 
run Python scripts in Autodesk Fusion. Select the Add-Ins tab to run the third party 
applications inside Autodesk Fusion 360. 

Creating Script and Add-Ins
•	 To create a script or Add-Ins, click on the Create button from Scripts and Add-

Ins dialog box. The Create New Script or Add-Ins dialog box will be displayed; 
refer to Figure-63.

Figure-63. Creating New Script

•	 Select Script radio button to create a script or select the Add-In radio button to 
create an Add-In. 

•	 Select the desired radio button from the Programming Language area to define the 
language in which you will be writing script/Add-in codes.

•	 Set the other parameters as required and click on the Create button. A new script/
Add-in will be added in the dialog box. 
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•	 Select the newly created script/Add-in and click on the Edit button. If the script/
Add-in is coded in Python then Spyder will start installing and once installation 
is complete, codes will be displayed; refer to Figure-64. If you have opted for any 
other language then system will ask you for respective Programming software 
to display codes. If you like coding then you can check Learning Python, 5th 
Edition by Mark Lutz as reference book for Python programming.

•	 Click on the Run button from the Scripts and Add-Ins dialog box to run selected 
script. 

•	 If you want to debug a script/Add-in then select it from the Scripts and Add-Ins 
dialog box and click on the Debug button in Run drop-down; refer to Figure-63. 
Programming interface will be displayed based on language of selected script/
Add-In.

Figure-64. Spyder application window

Fusion 360 App Store 
The Fusion 360 App Store tool in File menu is used to download and install third 
party Apps in Autodesk Fusion. On clicking this tool. a webpage is displayed in your 
default web browser; refer to .
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Figure-65. Fusion 360 Store webpage
•	 Login to your Autodesk account after clicking Sign In button at the top right in 

the web page.
•	 Select the desired app, set the desired Operating system and click on the Download 

button from web page; refer to Figure-66. The software will start downloading.

Figure-66. Downloading App
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•	 Once download, double-click on the setup file to install it and follow the instructions 
as displayed during installation. 

•	 Once the app is installed, you can access it from Add-Ins tab of Scripts and Add-
Ins dialog box; refer to Figure-67.

Figure-67. Installed app

UNDO AND REDO BUTTON 
The Undo tool is used to revert back to condition before performing most recent action. 
The procedure to use this tool is discussed next.

•	 Click on Undo tool in Application bar or press CTRL+Z keys; refer to Figure-68.
•	 You can’t undo some actions, like clicking commands on the File tab or saving 

a file. If you can’t undo an action, the Undo command changes to Can’t Undo. 

Figure-68. Undo and Redo
•	 The Redo tool is used to redo an action reverted by Undo tool. To use this tool, 

select the Redo button in Application bar or press CTRL+Y keys. 
•	 The Redo button only appears after you have undone an action.

USER ACCOUNT DROP-DOWN 
The tool in User Account drop-down are used to manage user account details and 
preferences for Autodesk Fusion 360; refer to Figure-69. The tools in this drop-down 
are discussed next.

Preferences 
The Preferences tool is used to set the preferences for various functions of the 
software like you can set units, material libraries, display options, and so on. The 
procedure to use this tool is given next.

•	 Click on Preferences tool from User Account drop-down; refer to Figure-69. The 
Preferences dialog box will be displayed where you can specify various parameters 
for application; refer to Figure-70. 
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Figure-69. User Account drop-down

Figure-70. Preferences dialog box

General 
In General node, you can specify the preferences for language, graphics, mouse 
functioning, default workspace and so on. Various important options are discussed 
next.

•	 Click on the General node at the left in the dialog box to display general options. 
•	 Click on the User language drop-down and select the desired language for Autodesk 

Fusion interface.
•	 Click on the Graphics driver drop-down to select the graphics driver to be used 

by Autodesk Fusion.
•	 Specify the number of days up to which your documents can be in the cache 

memory of Autodesk Fusion before you go back to online mode of Autodesk Fusion. 
If you specify high value then more local memory will be used by Autodesk Fusion 
to save temporary copy of your documents. If you specify a low value here then 
system will prompt you soon to go back online. The maximum number of days 
specified here can be 360 and minimum number of days can be 7.

•	 Select the Automatic version on close check box to automatically save the newer 
version of file when you close Autodesk Fusion.
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•	 Specify the desired time in minute after which a recovery copy of your model will 
be created in Automatic Recovery Save time interval  edit box.

•	 Click on the Default modeling orientation drop-down and select the desired 
direction option to define default orientation of model. In most of the CAD software, 
Z axis upward is the default orientation of model. To set the common orientation, 
select the Z up option from the drop-down.

•	 Set the other options as required in General page.
•	 Click on the API option under General node in the left of the dialog box and set 

the desired parameters to define default location and language of scripts/Add-Ins.
•	 Click on the Design option under General node in the left of the dialog box to set 

the parameters related to model creation. The options in the dialog box will be 
displayed as shown in Figure-71.

Figure-71. Design page
•	 Select the Capture Design History option from Design History drop-down if you 

want to keep detail of every operation you perform on the model. If you want to 
save space and want to hide operation details while sharing file then create the 
model after selecting Do not capture Design History option from the Design 
History drop-down. Note that most of the options will be active after you restart 
Autodesk Fusion.

•	 Set the default workspace in Default workspace drop-down.
•	 Select the Allow 3D sketching on lines and splines check box if you want to 

create lines and splines which are not confined to single plane.
•	 Similarly, set the other options as required on different nodes of the dialog box. 

We will work with options in this dialog box during rest of the book whenever a 
change in application settings is required.

•	 After setting the parameters, click on the OK button from the dialog box and restart 
Autodesk Fusion. 

The Autodesk Account tool in User Account drop-down is used to manage your 
Autodesk account profile. 

The My Profile tool in User Account drop-down is used to manage your project data 
stored on cloud via web browser.
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Work Offline/Online
The Work Offline/Online toggle button is displayed on clicking Job Status button at 
the left of User Account drop-down; refer to Figure-72. Click on this button to toggle 
between offline and online mode of Autodesk Fusion. 

Figure-72. Work Offline

 

HELP DROP-DOWN
When you face any problem working with Autodesk Fusion 360, the tools in Help 
drop-down can be useful; refer to Figure-73. Tools in the drop-down are given next.

Figure-73. Help

Search Help Box
When you are facing any problem regarding tools and terms in the software,then you 
need to type your problem in Search Box and press ENTER to find a suitable solution 
to your problems; refer to Figure-74. 

Figure-74. Search box

Learn Fusion 360 
The Learn Fusion 360 tool is used to learn about tools and topics related to software 
which are available on Autodesk website. On clicking this button, website of Autodesk 
Fusion 360 will be opened, where you can find the information related to software; 
refer to Figure-75. 

Figure-75. Learn fusion 360
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Getting Started
When you are new to Autodesk Fusion 360 then this tool will help you to understand 
this software terminology and basic settings. 

•	 Click on Getting Started tool from Help drop-down. The GETTING STARTED dialog 
box will be displayed.

•	 The navigation functions of mouse can be set as Autodesk Inventor, SolidWorks 
or Alias by using this tool and you can also set the units for your project; refer 
to Figure-76. 

Figure-76. Getting Started

•	 If you are new to CAD, then you can select the New to Cad in Cad Experience drop-
down menu. The mouse will function as per Autodesk Fusion 360 programming.

Similarly, you can use Community Forum, Gallery, Product Roadmap, Programming 
Interface and Submit an idea tool to get help from Autodesk Fusion 360 or provide 
feedback. 

Diagnostic log Files
When you are having a problem in Fusion 360 and want Technical support team 
to look at software problem data, then you can create the Log Files and send it to 
the support team of Autodesk.

•	 To create log files, select Diagnostic Log Files tool in Help drop-down. The 
Diagnostic Log Files dialog box will be displayed; refer to Figure-77. 

Figure-77. Daignostic Log Files
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•	 Click on Open File Location button and select the log file which you want to 

send to technical support team for the solution of problem.

Similarly, you can use Graphics Diagnostic, Clear user cache data, and other 
tools from Help drop-down in Autodesk Fusion 360.

DATA PANEL
Data Panel is used to manage the Autodesk Fusion 360 projects. The projects you 
save in cloud will be shown here. You can easily access the saved project files from 
anywhere and anytime with the help of internet access.

•	 To show or hide the Data Panel, click the Show Data Panel or Hide Data Panel 
button  at upper left corner of the Fusion 360 window; refer to Figure-78. 

Figure-78. Data Panel

•	 A box will be displayed with files of current project. In this box, there are two 
sections; Data and People.

•	 In Data section, the files which are saved earlier by you in current project are 
displayed. You will be able to open any file by double-clicking on it. 

•	 In People section, the information of users will be displayed who can access the 
files; refer to Figure-79. 
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Figure-79. People section in Data panel

Branch / Merge Options
The tools in this drop-down are used to create various categories of the current project 
like, we have master as our main branch and we are creating mechanical tools as 
another branch. At any point in entire project, you are able to create the branches. 
This helps you to manage your projects in a different category; refer to Figure-78. The 
steps to use this tool are given next. (Note that Autodesk Fusion was in the process 
of closing preview of this tool in version 2.0.4099 so you might not be able to utilize 
this tool any further.) 

•	 Click on Create Branch button from Branch / Merge Options drop-down; refer 
to Figure-80.

Figure-80. Create Branch

•	 On selecting the Create Branch button, the Create Branch dialog box will be 
displayed. You need to specify the location for branch in Branch from section and 
name in Branch name edit box. Note that once you have created a branch then 
you will not be able to rename or delete any created branch. File in the branch 
cannot be moved outside the branch or project. You can only move files from 
branch to master or master to master.

•	 After specifying the parameters, click on the Create button of Create Branch 
dialog box to create the Branch. 

Merge Push or Pull commands are only available, when there are more than one 
branch in your project. At least one file should be available in the folder to merge 
branch. Empty folders will not merge.
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Upload
The Upload tool is used to upload files on cloud. The procedure to use this tool is 
discussed next.

•	 Click on Upload button from Data Panel. The Upload dialog box will be displayed; 
refer to Figure-81. Click on the Select Files button or drag & drop the files to be 
uploaded.

•	 If you want to change the location where files will be uploaded then click on the 
Change Location button and select the desired location from the Change Location 
dialog box; refer to Figure-82. After selecting desired location, click on the Select 
button. You will return to Upload dialog box with updated location.

•	 After specifying the desired parameters, click on Upload button from Upload dialog 
box. File will be uploaded.

Figure-81. Upload file Data panel

Figure-82. Change Location dialog box
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The New Folder button in Data Panel is used to create a new folder. With the help 
of this tool, you can categorise your parts in different folders.

Cloud Account of User 
To open the cloud account of user, you need to select the arrow button (Leave Data 
Details button) which is displayed at the upper left corner of the Data Panel box. 
On selecting this button, details of user’s cloud storage will be displayed; refer to 
Figure-50.

•	 If you want to return to the previous screen, then click on the Back button which 
is highlighted in the figure.

•	 In Projects section, your projects are displayed. If you want to select the My Recent 
Data, Demo Project and any other project then double-click on the respective link.

•	 In Samples section, there are various samples and tutorial of design and project 
provided by Autodesk. To open any one of these samples double-click on the link. 

Figure-83. Leave Data Details

BROWSER 
The BROWSER presents an organized view of your design steps in a tree like structure 
on the left of the Fusion 360 screen; refer to Figure-51. When you select a feature or 
component in the BROWSER, it is also highlighted in the graphics window. 
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Figure-84. Browser

 

•	 Click on the Light bulb button to toggle the visibility of respective object. 
•	 If you select any object in BROWSER then it is highlighted in blue color which 

indicates that the respective object is active for various operations. 
•	 To change the units of the design or sketch, select the Change Active Units button 

as highlighted in the above figure. The CHANGE ACTIVE UNITS dialog box will be 
displayed. Select the desired unit and click on the OK button. 

NAVIGATION BAR
The Navigation Bar is available at the bottom of graphics window of Fusion 360. It 
provide access of navigation commands for design. To start a navigation command, 
click on any tool from the Navigation Bar; refer to Figure-85. 

Figure-85. Navigation Bar

There are various tool in Navigation Bar to navigate the model which are discussed 
next.
 
Orbit- The Orbit tools are used for rotating the current model. There are two types of 
orbit tools i.e. Free Orbit and Constrained Orbit. Free Orbit is used to rotate the 
design view freely and Constrained Orbit is used to rotate the view in constrained 
motion relative to current origin point. The Constrained Orbit tool is displayed on 
clicking down arrow next to Free Orbit tool. After selecting this tool, click at desired 
location on model and drag the cursor to rotate model view. You can do the same 
function by using SHIFT+middle mouse button dragging.
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Look At- This tool is used to view the selected of model parallel to screen. To use 
this tool, select the desired face of model and then click on the Look At tool from 
Navigation Bar.
Pan- It is used to move the design parallel to the screen. You can do the same function 
by middle mouse button drag. 
Zoom- It is used to increase or decrease the magnification of the current view. After 
selecting this tool, click on the model and drag mouse upward/downward to zoom 
out/in respectively. You can do the same function by rolling the mouse wheel up/
down. 
Zoom Window and Fit- Zoom window tools is used for magnification of selected area. 
Fit tool is used to position the entire design on the screen. You can do the same 
function as Fit tool does by pressing F6 from keyboard.

DISPLAY BAR
The tools of Display Bar are used to visualize the design in different viewports; refer 
to Figure-86. 

Figure-86. Display 
Setting

Display Setting- The Display Setting tool is used to enable or disable various 
commands like Desired Visual Style, Visibility of objects, and Camera 
settings, and so on. If you want to run Autodesk Fusion 360 in full screen then 
press CTRL+SHIFT+F from keyboard.

Grid And Snaps- The Grid and Snaps flyout is used to activate or deactivate various 
interface objects like Layout Grid, Layout Grid Lock, Snap to Grid, and so on. 
You can also define the size of grid and snapping increments by using Grid Settings 
and Set Increments tools in this flyout.

Viewports- The Viewports tool is used to display the model in four viewports at 
the same time on the Fusion 360 screen. You can set these views asynchronous by 
clearing the Synchronize Views check box from Viewports flyout after activating 
multiple viewports mode. If you want to move back to single viewport then select 
the Single View tool in Viewports flyout. By pressing SHIFT+! keys, you can toggle 
between single viewport and multiple viewports modes.

Viewcube 
The ViewCube tool is used to rotate the view of model to access different faces of model. 
Click at desired location on model and drag the ViewCube to perform a free orbit. There 
are six faces in ViewCube; Top, Bottom, Front, Back, Right, and Left to access 
different orientations of model. To access the standard orthographic and isometric 
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views, click on the faces and corners of the cube; refer to Figure-54. Right-click on 
the ViewCube to access options related to perspective mode and other view modes.

Figure-87. ViewCube

Mouse Functions
You can use the mouse shortcuts to zoom in/out, pan the view, and orbit the view, 
refer Figure-88.

•	 Scroll the Middle Mouse Button downward/upward to zoom in or zoom out, 
respectively. 

•	 Click and hold the Middle Mouse Button to pan the view.
•	 Use the Shift + Middle Mouse Button to orbit the view. 
•	 Click on the left mouse button select any object or tool.
•	 Click on the right mouse button (right-click) to access shortcut menus in the 

software.

Figure-88. Mouse shourtcut keys

Timeline 
The Timeline bar is very useful for saving time while editing. It records the design 
feature in chronological order; refer to Figure-56. Note that the Capture Design 
History (Parametric Modeling) option must be active in the Design node of 
Preferences dialog box to access Timeline bar. 

Figure-89. Timeline

If you want to edit any feature of model, then double-click on the respective feature 
from Timeline bar. The respective dialog box/interface element will be displayed. Make 
the desired changes and apply the parameters. The final design will be generated 
automatically with the applied changes; refer to Figure-90.
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Figure-90. Editing model from timeline
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SELF ASSESSMENT
Q1.  ...............is used to manage the fusion 360 project.

Q2.  Which tool is used to share the files to GrabCad?

Q3.  The...............button is used for producing CNC codes.

Q4.  Which of the following workspace is not available in Autodesk 	Fusion 360 ap-
plication?

a.   Patch Workspace
b.   Model Workspace
c.   Assemble Workspace
d.   Drawing Workspace

Q5.  Discuss the use of Save tool with example.

Q6.  Discuss the process of exporting a project in computer with example.

Q7.  Discuss the use of 3D Print tool with example.

Q8.  Which tool is used to generate Toolpaths for model?

Q9.  How to reset the default layout?

Q10. Explain the process of creating Script with example.
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For Student Notes



Chapter  2

Sketching

Topics Covered

The major topics covered in this chapter are:

•	 Starting Sketch
•	 Sketch Creation Tools
•	 Sketch Editing Tools
•	 Sketch Palette
•	 Constraints
•	 Sketching Practical and Practice
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INTRODUCTION
In Engineering, sketches are based on real dimensions of real world objects. These 
sketches work as building blocks for various 3D operations. In this chapter, we will 
be working with sketch entities like; Line, Circle, Arc, Polygon, Ellipse and so on to 
form base feature for various 3D operations. Note that the sketching environment is 
the base of 3D Models so you should be proficient in sketching.

In this chapter, we will be working in Model Workspace. We will learn about various 
tools of toolbar used in sketching and 3D Sketching.

STARTING SKETCH
•	 To start a new sketch, click on the Create Sketch tool from SKETCH drop-down in 

Toolbar; refer to Figure-1. The three primary planes will be displayed on canvas 
screen; refer to Figure-2.

Figure-1. Create Sketch

Figure-2. Select Plane for Sketch

•	 Click on the desired plane from the canvas screen. The selected plane will become 
parallel to the screen and act as current sketching plane. Now, we are ready to 
draw sketch on the selected plane.

First, we will start with the sketch creation tools and later, we will discuss the other 
tools.
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SKETCH CREATION TOOLS
In SKETCH drop-down, there are various tools for creating sketch entities. These tools 
are discussed next. 

Line
The Line tool is used to create a line. The procedure to use this tool is discussed next.

•	 Click on Line tool of SKETCH drop-down from Toolbar; refer to Figure-3. You can 
also press L key to select the Line tool. You will be asked to specify start point 
of the line.

Figure-3. line

•	 Click at desired location to specify start point and move the cursor away from 
selected point in desired direction in which you want to create the line. Angle and 
Length edit boxes will be displayed with the preview of line. 

•	 Enter the desired value of length in the Length edit box. Press TAB key to toggle 
to Angle edit box; refer to Figure-4.

Figure-4. making of line

•	 If you are making a freestyle line then click on the screen at desired location without 
specifying any value in Length and Angle edit boxes. Press ESC after specifying 
end points to exit the tool.

•	 To create a line for construction purpose, click on the Construction button from 
SKETCH PALETTE displayed at the right in the application window after activating 
Line tool; refer to Figure-5. (You will learn more about SKETCH PALETTE later in this 
chapter.) You can also right-click on the line after creating it and then click on 
Normal/Construction button from Marking menu to do the same; refer to Figure-6.
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Figure-5. Construction button in 
SKETCH PALETTE

Marking menu
It is the radical display of most frequently used tool and tools related to selected 
entities. This menu also provide a quick access to the tools of the toolbar. This menu 
is the fastest way to activate the tool. To access this menu, right-click anywhere on 
the screen within the graphics window. To select any tool of this menu, move the 
cursor towards the tool and the tool will be highlighted. Click on it to activate the tool.

Figure-6. Marking menu

Rectangle
The tools in Rectangle cascading menu are used to create rectangles. There are three 
tools in Rectangle cascading menu; 2-Point Rectangle, 3-Point Rectangle, and 
Center Rectangle; refer to Figure-7.

Figure-7. Rectangle drop-down

You can also activate the Rectangle tool by pressing R key while in Sketch mode. 
The procedure to use these tools are discussed next.



Autodesk Fusion 360 Black Book                               2-5

2-Point Rectangle
•	 Click on the 2-Point Rectangle tool of the Rectangle cascading menu from SKETCH 

drop-down. You will be asked to specify the first point.
•	 Click on the sketch canvas to specify first point of rectangle. You will be asked to 

specify the other corner point; refer to Figure-8.

Figure-8. 2-Point Rectangle tool

•	 Specify the length and width of rectangle in the dynamic input boxes. To switch 
between the length dynamic input box and width dynamic input box, press TAB 
key.

•	 After specifying the parameters, press ENTER to create the rectangle. To exit the 
tool, press ESC key.

•	 If you want to create a freestyle rectangle then click on the screen to select the 
first corner point and last corner point of the rectangle on the sketch canvas.

•	 To add dimensions, right-click on the line of rectangle and click on Sketch 
Dimension tool from the Marking menu. You can also activate the Dimension tool 
by pressing d from keyboard after selecting the line. You will learn more about 
dimensioning later in this chapter.

3-Point Rectangle
•	 Click on the 3-Point Rectangle tool of Rectangle cascading menu from SKETCH 

drop-down. You will be asked to specify location of first corner point of rectangle.
•	 Click at the desired location to specify first corner point of the rectangle on the 

sketch canvas; refer to Figure-9.

Figure-9. Creation of 3-point rectangle
•	 Click to specify the second corner point (end point of base like of rectangle) on 

the canvas or specify the dimension in dimension box.
•	 Click to specify the third corner point of the rectangle to create the complete 

rectangle creation.

Center rectangle
•	 Click on the Center Rectangle tool of the Rectangle cascading menu from SKETCH 

drop-down. You will be asked to specify center point of the rectangle.
•	 Click on the canvas to specify the center point of the rectangle; refer to Figure-10.
•	 Enter the dimension for rectangle in the edit boxes and press ENTER to create the 

rectangle.
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Figure-10. Creation of center rectangle
•	 If you want to create free style rectangle then click on the screen to select the 

center point and corner point of rectangle.

Circle
There are five tools in Circle cascading menu to create circles; Center Diameter 
Circle, 2-Point Circle, 3-Point Circle, 2-Tangent Circle, and 3-Tangent 
Circle; refer to Figure-11.

Figure-11. Circle tool

The shortcut key to use the Center Diameter Circle tool is pressing C key from 
keyboard. The tools to create circle are discussed next.

Center Diameter Circle
The Center Diameter Circle tool is used to create circle specifying center location 
and diameter value.
 
•	 Click on the Center Diameter Circle tool from Circle cascading menu. 
•	 Click to specify the center point for the circle; refer to Figure-12.

Figure-12. Creation of center diameter circle
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•	 Click to specify the circumferential point or enter desired value of diameter in the 

dynamic input box.

2-Point Circle
The 2-Point Circle tool is used to create circle by specifying two circumferential 
points. The procedure to use this tool is discussed next.

•	 Click on the 2-Point Circle tool of Circle cascading menu from SKETCH drop-
down and specify the first point for circle; refer to Figure-13.

Figure-13. Creation of 2-point circle
•	 Specify the second point on the canvas screen or enter the diameter dimension 

in the dynamic input box and press ENTER key.

3-Point Circle
The 3-Point Circle tool is used to create circles using 3 circumferential points as 
references. The procedure to use this tool is discussed next.

•	 Click on 3-Point Circle tool from Circle cascading menu of SKETCH drop-down. 
•	 Click on the screen to specify the first point, second point and third point of circle; 

refer to Figure-14.

Figure-14. Creation of 3-point circle

•	 Right-click on the screen and click OK button from Marking menu to complete the 
process. You can also press ESC key to exit the circle tool.

•	 If you want to add dimensions then right-click on the selected circle and click 
on the Sketch Dimension tool from Marking menu. You can also select Sketch 
Dimension tool from SKETCH drop-down.
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2-Tangent Circle
The 2-Tangent Circle tool is used to create a circle which is tangent to two selected 
lines. The procedure to use this tool is discussed next.

•	 Select 2-Tangent Circle tool of Circle cascading menu from SKETCH drop-down. 
•	 Click at desired locations on lines that should be tangent to the circle; refer to 

Figure-15. Preview of circle will be displayed

Figure-15. Creation of 2-tangent circle

•	 Enter the desired radius of the circle in the floating window and press ENTER to 
create a circle or click at the desired location to create the circle. 

•	 Press ESC to exit the tool.

3-Tangent Circle
The 3-Tangent Circle tool is used to create a circle using three tangent lines. The 
procedure to use this tool is discussed next.

•	 Click on 3-Tangent Circle tool of Circle cascading menu from SKETCH drop-down.
•	 Select three lines to be tangent to the circle. You can use perform window selection 

to select the lines; refer to Figure-16.
•	 A preview of circle will be displayed. Right-click on the screen and click OK button 

from Marking menu to complete the process. You can also press ESC key to exit 
the tool.

Figure-16. Creation of 3-tangent circle
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Arc
The Arc tool is used to create arcs. There are three tools in the Arc cascading menu; 
3-Point Arc, Center Point Arc, and Tangent Arc; refer to Figure-17.

Figure-17. Arc

The tools of Arc cascading menu are discussed next.

3-Point Arc
The 3-Point Arc tool is used to create an arc using three points (start point, end point, 
and circumferential point). To use this tool, you need to specify two end points and 
one circumferential point of the arc. The procedure to use this tool is discussed next.

•	 Click on 3-Point Arc tool of Arc cascading menu from SKETCH drop-down. Select 
the desired plane or face from canvas screen if not selected yet.

•	 Click on the screen to specify the start point of the arc; refer to Figure-18.

Figure-18. Creation of 3-point arc

•	 Click on the screen to specify the end point of the arc.
•	 Click at desired location to define the radius of arc. The arc will be created.
•	 Press ESC to exit the tool.

Center Point Arc
The Center Point Arc tool is used to create arc by defining center point, start point, 
and end point of the arc. The procedure is given next.

•	 Click Center Point Arc tool of Arc cascading menu from SKETCH drop-down. You 
will be asked to specify center point of the arc.

•	 Click on the screen canvas to specify the center point of arc.
•	 Click to specify the start point of the arc or enter desired value of radius in dynamic 

input box.
•	 Enter the desired angle value in dynamic input box to define length of arc or click 

on the screen to specify the end point of the arc; refer to Figure-19.

Figure-19. Creation of center point arc
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•	 The arc will be displayed. Right-click on the screen and click OK button from 
Marking menu to exit the tool. You can also press ESC key to exit the tool.

Tangent Arc
The Tangent Arc tool is used to create arc tangent to selected entity. 

•	 Click on the Tangent Arc tool from Arc cascading menu in SKETCH drop-down.
•	 Click near the end point of an entity (line, arc or curve) from screen to specify 

the start point of the arc; refer to Figure-20. A rubber-band arc will be attached 
to cursor starting from selected point.

•	 Click at the desired location to specify the end point of the arc.

Figure-20. Creation of tangent arc

•	 Right-click on the screen and click OK button from Marking menu to complete the 
process. You can also press ESC key to exit the arc tool.

What happens when you try to create an arc at corner location where two entities 
meet and selected point is common to both the entities; refer to Figure-21. Will the 
arc be created tangent to line 1 or line 2? What if the arc is being created tangent to 
line 1 but we want to create it tangent to line 2. In such conditions, after selecting 
end point, move the cursor in line with entity to be tangent for few millimeters and 
then specify the end point at desired location; refer to Figure-22.

Figure-21. Tangent arc problem at corner point



Autodesk Fusion 360 Black Book                               2-11

Figure-22. Creating arc tangent to line 2

Polygon
The Polygon tool is used to create polygon of desired number of sides. There are 
three tools to create polygon in Polygon cascading menu; Circumscribed Polygon, 
Inscribed Polygon, and Edge Polygon; refer to Figure-23. The tools to create the 
polygons are discussed next.

Figure-23. Polygon

Circumscribed Polygon
Use the Circumscribed Polygon tool to create a polygon formed outside the reference 
circle. Note that midpoints of polygon lines will lie on the reference circle. The 
procedure to use this tool is discussed next.

•	 Click on the Circumscribed Polygon tool from Polygon cascading menu in SKETCH 
drop-down; refer to Figure-23. You will be asked to specify center point of the 
reference circle.

•	 Click on the screen to specify the center point of the polygon; refer to Figure-18. 
You will be asked to specify radius of reference circle.

 

Figure-24. Creation of circumscribed polygon

•	 Enter the value of radius in the edit box and press TAB to activate Edge Number 
edit box.



2-12				    Autodesk Fusion 360 Black Book               

•	 Specify desired number of edges of the polygon in Edge Number edit box.
•	 After specifying the parameters, press ENTER to create polygon.

Inscribed Polygon
The Inscribed Polygon tool is used to create a polygon formed inside the reference 
circle. The procedure to use this tool is discussed next.

•	 Click on Inscribed Polygon of the Polygon cascading menu from SKETCH drop-
down. You will be asked to specify center point of reference circle.

•	 Click on the screen to specify the center point of the circle; refer to Figure-25.
•	 Enter the distance between center point of polygon and vertex of polygon edge in 

dynamic input box.

Figure-25. Creation of inscribed polygon

•	 Press TAB and specify the value of number of edges in Edge Number dynamic input 
box.

•	 Press ENTER to create polygon.

Edge Polygon
The Edge Polygon tool is used to create a polygon by defining single edge and number 
of edges of the polygon. The procedure to use this tool is discussed next.

•	 Click the Edge Polygon tool of the Polygon cascading menu from SKETCH drop-
down. 

•	 Click on the screen to select the start point and end point of edge. You can also 
specify the value of angle and distance of the edge in dynamic input boxes; refer 
to Figure-26.

•	 Specify the value of number of edges of polygon in Edge Number edit box.

Figure-26. Creation of edge polygon


